
Assessment – 1 Introduction of Computer 
 

1. Which generation of computers uses Integrated Circuits (LCS)? 

a) First 

b) Second 

c) Third 

d) Fourth 

 

 

2. The ability to do many tasks simultaneously is called. 

a) Diligence 

b) Varsality 

c) Reliability 

d) All of the above 

 

3. When and where was India's first computer installed? 

a) Indian Institute of Science, Bangalore, 4953 

b) Indian Institute of Technology, Delhi,1496) 

c) Indian Statistical Institute, Calcutta, 1955 

d) Indian Institute of Technology Delhi, 1957 

 

4. What is meant by dedicated computer? 

a) Which is designed for only one task. 

b) Which uses 4 types of software. 

c) Which is used by only 4 people. 

d) Designed for application software. 

 

5. LCD means 

a) Liquid Crystal Display 

b) Liquid Color Display 

c) None of the above 

 

6. Who started the personal computer industry? 

a) HCL 

b) Apple 

c) IBM 

d) Compaq 

 

7. Which component was used as CPU in the second generation computers? 

a) Vacuum tubes 

b) Transistor 

c) LSI Chip 

d) VLSI Chip 

 

8. What name has been given to the molecular scale computer? 

a) Super computer 

 



b) Microcomputer 

c) Nano computer 

d) Fermo computer 

 

9. Which of the following are valid types of computers based on data management capabilities? 

a) Analog computer 

b) Digital computer 

c) Hybrid computer 

d) All of the above 

 

10. Which of the following is the smallest and fastest computer that can imitate the functioning 

of the brain? 

a) Super computer 

b) Quantum computer 

c) Mainframe computer 

d) PDA 

 

11. India's first supercomputer? 

a) Fire 

b) Flow solver 

c) Param 
d) Trishul 

 

12. All modern computers work on? 

a) Field 

b) Word 

c) E-formation 

d) Data 

 

13. Desktop and personal computers are also known as………….. 

a) Super computer 

b) Quantum computer 

c) Mainframe computer 

d) Microcomputer 

 

14. Stored program concept was developed by…………? 

a) Maurice Wilkes 

b) John von Neumann 

c) Charles Babbage 

d) None of the above 

 

15. Which of the following is not a classification of computers on the basis of application? 

a) Electronic computer 

b) Digital computer 

c) Neither of them 

d) All of the above 



 

 

16. What is the correct order of the four main functions of a computer? 

a) Process--Output-Input-Storage 

b) Input-Process-Output-Storage 
c) Input-Output-Process-Storage 

d) Process-Storage-Input-Output 

 

17. Where did the word computer originate? 

a) Greek 

b) German 

c) Sanskrit 

d) Latin 
 

18. By whom was the basic architecture of computer first developed? 

a. Blaise Pascal 

b. Garden Moor 

c. Charles Babbage 

d. John von Neumann 

 

19. Which of the following is a handheld operating system?  

a) Super computer 

b) Laptop 

c) Mainframe computer 

d) PDA 

 

20. What technology was the VLSI technology converted to during the fifth generation? 

a. ULSI 
b. CLSI 

c. KLSI 

d. LSI 

 
Assessment-2 Computer System 
1. ..............keyboards are more compact. 

a) Kwerty 
b) Macintosh 
c) Laptop 
d) Windows 

 
2. The output quality of a printer is measured by- 

a) Dot per square inch 
b) Dots Per Inch 
c) Dots printed per unit 
d) All of the above 

 
3. By what is the conversion of input into output done? 



a) CPU 
b) Memory 
c) Storage 
d) All of the above 

 
4. Floppy disks are 

a) Fast storage 
b) Flexible storage 
c) Permanent storage 
d) None of the above 

 
5. Microprocessor can be used for manufacturing industry. 

a) Computer 
b) Digital System 
c) Calculator 
d) All of the above 

 
6. Responds to commands coming through #7 of the computer. 

a) Control section 
b) Cache memory 
c) Primary memory 
d) External memory 

 
7. CPU does not work 

a) Logical operation 
b) Transfer of data 
c) Arithmetic calculation 
d) All of the above 

 
8. What is the function of control unit in CPU? 

a) Decoding the primary instruction 
b) Transferring data to primary storage 
c) To conduct logical operations 
d) Storing program instructions 

 
9. A small or intelligent device is so called because it contains 

a) Computer 
b) Microcomputer 
c) Programmer 
d) Sensor 

 
10. It is the brain of any computer system. 

a) ALU 
b) Memory 
c) CPU 
d) Control Unit 

 
11. RAM is called: 



a) Non-volatile storage 
b) Read/Write memory 
c) core memory 
d) none of the above 

 
12. The data feed into the computer is called. 

a) Output 
b) Algorithm 
c) Input 
d) Flow chart 

 
13. Who used punch cards practically for the first time in the history of computers? 

a) Charles-Babge 
b) harked.aken 
c) Herman Hollerith 
d) Joseph Jacquard 

 
14. Which of the following has the largest memory size? 

a) Terabyte 
b) KILOBYTE 
c) Gigabyte 
d) Megabyte 

 
15. Which of the following are input devices? 

a) Scanner 
b) Mouse 
c) JOYSTICK 
d) All of the above 

 
16. Cache memory acts as a buffer between? 

a) RAM and ROM 
b) RAM and CPU 
c) ROM and CPU 
d) Hard disk and CPU 

 
17. Laser printer speeds are measured 

a) CPM 
b) DPI 
c) PPM 
d) LPM 

 
18. What is light pen? 

a) Optical output device 
b) Electronic output device 
c) Optical input device 
d) Electronic input device 

 
19. Main storage is also called this. 



 Register 
a) Memory 
b) CPU 
c) Control unit 
d) None of the above 

 
20. Which swapping device is used to store images of pages in main memory? 

a) Punch card 
b) OMR 
c) Paging drum 
d) None of the above 

 
21. OMR represents- 

a) Optical manual reader 
b) Optical mark recognition 
c) Operator Mark Reader 
d) Optional mark reader 

 
22. Hard disks are coated on both sides by- 

a) Optical metallic oxide 
b) Carbon layer 
c) Magnetic metallic oxide 
d) All of the above 

Assessment-3 Exploring Your Computer 
 

1. Which of the following is not an operating system? 
a) Windows 
b) DOS 
c) Oracle 
d) Linux 

 
2. Full form of NTFS is. 

a) New Type File System 
b) New Terminated File System 
c) New Technology File System 
d) Never Terminated File System 

 
3. In Control Panel, there is an icon used to change the screen saver. 

a) System setting 
b) Regional setting 
c) Aid program 
d) Display 

 
4. The screen background and main area in Windows where you can open and manage files and 
programs,lled- 

a) Background 
b) Desktop 



c) Wallpaper 
d) None of the above 

 
5-.WYSIWYG 

a) What you see is what you gain 
b) What you see is what you get 
c) What you see is what you gain 
d) What you see is what you gain 

 
6. The date and time is displayed. 

a) Taskbar 
b) Status Bar 
c) System Tray 
d) Launch Pad 

 
7. To permanently delete a file or folder in the computer, we use it. 

a) Enter+Delete 
b) Ctrl+Delete 
c) Shift+Delete 
d) Alt+Delete 

 
8. Software agents are also known by these names. 

a) Transagents 
b) Nobots 
c) Blizzards 
d) Softbots 

 
9. What is the main objective of the redesigned Microsoft Store in Windows 11? 

a) Selling hardware 
b) Distributing software 
c) Streaming movies 
d) All of the above 

 
10. Which technology integrated into Windows 11 enables users to run Android apps on their PC? 

a) Windows Store 
b) Microsoft Edge 
c) Project Late 
d) Windows Defender 

 
11. Which of the following Windows does not have a Start button? 

a) Windows 8 
b) Windows Vista 
c) Windows 7 
d) None of the above 

 
12. Map.net GIS software product works on ..............Operating System. 

a) Windows 
b) Linux 



c) Redhead 
d) Mac 

 
13. Microsoft Windows is a………….. 

a) Database program 
b) Word growing 
c) Graphic program 
d) Operating system 

 
14. What are the requirements to boot a computer? 

a) DBMS 
b) Modem 
c) Operating system 
d) MS Office 

 
15. In operating systems, response times are very important. 

a) Multitasking 
b) Batch 
c) Real time 
d) Online 

 
16. Recently deleted files are stored. 

a) Recycle bin 
b) C:\> 
c) Desktop 
d) My computer 

 
17. Which feature widget in Windows 44 focuses on creating personalized feeds of news and other 
content? 

a) Live Tiles 
b) Start Menu 
c) Task bar 
d) Widgets 

 
18. In GUI    which is not a feature of a program that makes it easier for the user to learn a program? 

a) WYSIWYG 
b) Dialog box 
c) Details keystrokes and commands 
d) Icons 

 
19. Loading of operating system is called? 

a) Formatting 
b) Booting 
c) Debugging 
d) Compiling 

 
20. Which of the following is not a function of 05? 

a) Virus protection 



b) Memory management 
c) Disk Management 
d) Application Management 

 
21. Booting instructions are stored inside. 

a) RAM 
b) Operating system 
c) Floopy disk 
d) ROM 

  

Assessment-4 Introduction of Internet 
1. Search results are usually presented in a row of results often called 

a) Tag list 
b) Search engine result page 
c) Search engine page 
d) Category 

2. Which of the following search engines is especially for scientific information? 
a) Google 
b) Yahoo 
c) Cyrus 
d) Alta Vista 

3. Which language is generally used to create World Wide Web pages? 
a) URL 
b) IRC 
c) NIH 
d) HTML 

4. Email contains all the basic elements except the following. 
a) Header 
b) Footer 
c) Message 
d) Signature 

5. Which of the following is called protocol in http://www.google.co.in? 
a) .co 
b) .in 
c) www 
d) HTTP 

6. If you need to send the same message to more than one person (for information), 
a) So Re-mail each one individually 
b) Use forward option in email 
c) Use CC option in email 
d) None of the above 

7. There are symbols used in email addresses. 
a) & and, 
b) # and - 
c) @ and – 
d) #and, 

 



8. Which software application runs automated tasks on the Internet? 
a) Internet bot 
b) Web browser 
c) Session 
d) Cookies 

9. Due to which factor, coaxial cables are less sensitive to noise? 
a) Inner conductor 
b) Cable diameter 
c) Outer conductor 
d) insulating material 

10. What are search engines? 
a) A program that searches the engine 
b) A hardware component 
c) A machinery that searches data 
d) A program that searches websites 

11. Search engines that take input from users and also send queries to third party search engines for 
results are. 

a) Advanced search engine 
b) Meta search engine 
c) Search dust 
d) Boolean search engine 

12. Which of the following is not a search engine? 
a) Yahoo 
b) Bing 
c) Google 
d) Windows 

13. WWW means 
a) Word wide web 
b) Web-Wide Web 
c) Widest Wide Web 
d) World Wide Web 

14. Junk email is called- 
a) Spool 
b) Spam 
c) Spoof 
d) Script 

15. E-mail means- 
a) Electronic Gel 
b) Electronic message mail 
c) Electronic mail 
d) Electromechanical mail 

16. What is Mozilla Firefox? 
a) Icon 
b) Browser 
c) File manager 
d) Internet 

17. Which of the following was the first commercial web browser? 
a) Mosaic 



b) Mozilla 
c) Netscape 
d) Internet Explorer 

18. URL means. 
a) Uniform Reference Locator 
b) Uniform Resource Locator 
c) Universe Resource Locator 
d) Unique Reference Label 

19. The e-mails you receive appear as follows: 7 
a) Inbox 
b) Sent Mail 
c) Messenger. 
d) Contacts 

20. Saving a file from internet to computer is called. 
a) Downloading 
b) Uploading 
c) Storing 
d) Weblinking 

  
 
 

Assessment-5 Financial Literacy and Digital Payments Applications 
Assessment-5 Financial Literacy and Digital Payments Applications 
 
1. Which digital payment platforms are linked to the buy now, pay later (8087.) retention? 

a) PayPal 
b) Venmo 
c) After pay 
d) JAIL 

2. What is the meaning of the term tokenization in mobile payments? 
 Conversion of physical currency into digital currency 

a) Encrypt the transmitted payment information 
b) Creating virtual representations of credit cards 
c) Contactless transactions using NFC 
d) None of the above 

3. Which digital payment method generally involves scanning a code 00 for a transaction? 
a) Contactless card 
b) Mobile banking 
c) Cryptocurrency 
d) QR code payment 

4. What is the meaning of the term contactless payer in the context of mobile payment? 
a) Use mobile device*without. pay 
b) Without physical contact with the payment terminal 
c) Making payment through contact list in mobile app 
d) Money transfer using Bluetooth technology 

 



5. Which of the following are possible risks associated with online banking? 
a) Unlimited access 
b) Less facilities 
c) Phishing attacks 
d) Low interest rate 

6. When is money transmission processed in RTGS? 
a) For an hour 
b) Daily 
c) Immediately 
d) Weekly 

7. Which digital payment was launched to promote cashless transactions in India? 
a) Apple Pay 
b) On Wechat 
c) Alipay 
d) Unified Payments Interface (UPI) 

8. What is the role of Mobile POS (Point of Sale) in mobile payments? 
a) Managing mobile phone settings 
b) To make payments at physical stores 
c) Customer service center of mobile network provider 
d) Mobile app development platform 

9. Which of the following is an example of a P2P digital payment platform? 
a) Paypal 
b) Venno 
c) Apple Pay 
d) Google Pay 

10. Which type of online banking service allows users to take pictures with their mobile devices?  
a) Mobile banking 
b) Internet banking 
c) E-commerce banking 
d) Virtual Banking 

11. Internet banking facility is called. 
a) Online 58॥ 

b) Net Banking 
c) e pe 
d) SBI Connect 

12. What is the purpose of virtual card in online banking? 
a) Physical credit card for online shopping 
b) A temporary, disposition for securing transactions 
c) Digital representation of traditional bank card. 
d) A card which can be used for special virtual accommodation 

13. RTGS is mainly used for transfer of funds in the following ranges? 
a) Up to Rs 40,000 from small cash transactions 
b) For medium transactions between Rs 10,000 and Rs 1 lakh 
c) For large transactions above Rs 2 lakh 
d) All transactions based on amount 

14. What is the main objective of phishing attack in the context of online banking? 
a) Stealing physical bank cards 
b) Deauthorizing users' account information 



c) Providing financial advice 
d) Promoting online banking facilities 

15. Which of the following is correct about NEFT transactions? 
a) They are processed in real time? 
b) These have settlement time throughout the day. 
c) They are limited to maximum transactions 
d) They operate only on weekdays. 

16. What does NFC mean in the context of digital payments? 
a) National Finance Corporation 
b) Near Field Communication 
c) Non-fungible currency 
d) Network File Control 

17. What are the main objectives of a payment gateway in online transactions? 
a) Digital receipt storage 
b) To facilitate communication between banks 
c) Converting digital currency into physical cash 
d) Sending promotional emails 

18. What is the purpose of CVV (Card Verification Value) in online credit card transactions? 
a) Card expiry date 
b) Name of the cardholder 
c) Security code for authentication 
d) Card balance information 

19. Which digital payment method is designed for international money transfer and is used for its 
a) Cryptocurrencies PayPal 
b) Alipay 
c) Western Union 
d) Bitcoin 

20. What is the main purpose of digital wallet in online payment? 
a) Physical cash collection 
b) sending email 
c) Collection and management of digital payment* information 
d) Tracking the trend in the stock market 

21. What is the password for online banking transactions? 
a) Logging in to Achiladan Banking Portal 
b) Confirming specific transactions 
c) Changing account settings 
d) Recovering forgotten password 

22. CDC means core banking. 
a) Central Data Center 
b) Core Data Center 
c) Core Development Center 
d) None of the above 

 
 
 

Assessment-6 Internet Applications 



 
1. The dimension of e-commerce that enables commerce across national boundaries is called………….. 

a) goes Interactivity 
b) Prosperity 
c) Worldwide Reach 
d) Specifically 

2. EDI means. 
a) Electronic data is invisible 
b)  Electronical data is invisibleonic data invisibl 
c) ectronic DaElectronic Data IntercjhangeInterchange 

d) None of the above 
3. Was the primary source of financing during the early years of e-commerce. 

a) Big Retail Companies 
b) Bank Loan 
c) Initial public offers 
d) Venture capital fund 

4. What are the primary features of social networking sites? Which allows users to share images and 
short videos? 

a) Status update 
b) StoriesStories 

c) Timeline 
d) Checkincheck in 

5. ...... is an early form of e-commerce. 
a) EDI 
b) SCM 
c) Both of the above 
d) None of the above 

6. Which payment method, abbreviation COD, is commonly associated with online shopping? 
a) Credit on delivery 
b) Cash on delivery 
c) Check on delivery 
d) Charge on delivery 

7. Which is not an example of G2C services? 
a) E-Visa 
b) E-Transportation 
c) Digital Police Portal 
d) e-bay.com 

8. eBay is an example of which segment? 
a) B2B 
b) C2B 
c) B2C 
d) None of the above 

9. Which type of e-commerce focuses on consumers interacting with each other? 
a) C2B 
b) C2C 
c) B2C 
d) None of the above 



10. Digital signature does not provide………… for the message. 
a) Authentication 
b) Non-repudiation 
c) Confidentiality 
d) integrityIntigrity 

11. Which of the following is not one of the major types of e-commerce? 
a) B2C 
b) C2B 
c) B2B 
d) C2C 

12. What is the purpose of like or heart button on social media platforms? 
a) To bookmark content for later. 
b) To express approval or appreciation 
c) To share content with friends 
d) Reporting inappropriate content 

13. Which social networking site was originally designed for college students but later expanded to the 
general public? 

a) LinkedIn 
b) Facebook 
c) Instagram 
d) Twitter (X) 

14. A digital signature 
a) The bit string provides the name of the contact. 
b) A unique identity of the sender 
c) By typing specifically for the sender only 
d) Printed signature of the sender 

15. Which social networking site is famous for its character limit in posts? 
a) Facebook 
b) Twitter (x) 
c) LinkedIn 
d) Pinterest 

16. What do the words hashtag represent on social media platforms? 
a) A way to identify spam 
b) A link to external websites 
c) cClassification of content 

d) Personalized emoji 
17. What is the primary purpose of social networking sites? 

a) Online shopping 
b) Connecting and interacting with others 
c) Gumming 
d) News broadcasting 

18. EDI is necessary. 
a) E-Visa 
b) E-Transportation 
c) Digital Police Portal 
d) e-bay.com 

 
19. Digital products are best suited for B2C e-commerce because they are 



a) Extensively customized and personalized 
b) Can be delivered at the time of purchase 
c) Goods are products like 
d) All of the above 

20. Which of the following is a popular online marketplace where individuals and businesses can sell 
products? 

a) Google 
b) eBay 
c) Twitter (X) 
d) LinkedIn 

 
 
 

Assessment-7 Working with Mobile Devices / Smartphone 

 
1. Wi-Fi will expand 

a) Wireless flash 
b) Wireless fidelity 
c) Wide fidelity 
d) All of the above 

2. Which is the open-source operating system used in mobile devices including smartphones/tablets? 
a) iOS 
b) Windows 
c) Android 
d) Mac OS 

3. The process of  GPS signal purification using additional non-GPS data sources is called? 
a) GPS enhancement 
b) GPSGPS Augmentation Augmentation 

c) GPSGPS Correction correction 
d) GPS Optimization 

4. What are the range meters of a typical WiFi network? 
a) 50 meters 
b) 100 meters 
c) 200 meters 
d) 500 meters 

5. What are the primary functions of a fitness tracker as a handheld device? 
a) Gaming 
b) Navigation 
c) Health and activity monitoring 
d) Document editing 

6. Bluetooth has access methods 
a) FDMA 
b) TDD-TDMA 
c) CDMA 
d) None of the above 

7. What is the purpose of Bluetooth Special Internet Group (SIG)? 



a) Developing Bluetooth software 
b) Promoting Bluetooth technology and maintaining standards  
c) Manufacturing Bluetooth hardware 
d) Regulating Bluetooth frequencies 

8. Which organization is responsible for defining WiFi standards? 
a) IEEE 
b) ISO 
c) ITU 
d) IETF 

9. What is the maximum data transfer rate of Bluetooth 5.0? 
a) 1 Mbps 
b) 2 Mbps 
c) 5 Mbps 
d) 10Mbps 

10. Which segment of the GPS system consists of ground-based control stations that manage satellites 
and monitor their signals? 

a) GPS space segment 
b) GPS control segment 
c) GPS user segment 
d) Satellite segment 

11. Which WiFi devices connect without entering password using push button or PIN method 
a) toWEP 
b) WPA2 
c) WPS 
d) WPA3 

12. In which type of networks Bluetooth technology is used? 
a) PAN 
b) LAN 
c) WAN 
d) MAN 

13. In Bluetooth terminology, what are pairing codes used for? 
a) Establishing a connection 
b) transmitting data 
c) encryption 
d) Power management 

14. Which of the following is an example of a handheld device? 
a) Desktop computer 
b) Laptop 
c) Smartphone 
d)  serverServer 

15. Which of the following is a commonly used WiFi frequency band for short distance and high speed 
communications? 

a) 900 MHz 
b) 2.4 GHz 
c) 5 GHz 
d) 10 GHz 

16. Which feature allows handheld devices to determine their geographic location? 
a) Global Positioning System 



b) Near Field Communication 
c) Bluetooth 
d) Infrared 

17. What are the primary purposes of handheld devices? 
a) Heavy computational 
b) Portable and on-the-go computing 
c) Network Administration 
d) Graphic design 

18. What is Bluetooth? 
 
 
 
 
 
 

a) A Wireless Internet Protocol Wireless Internet Protocol 

b) Short range wireless communication technology 
c) Satelite Communicaton Type of satellite communication 
d) Fiber Optic Communication Standard 

 
19. What are the primary uses of Bluetooth in Hands-Free Profile (HFP)? 

a) File sharing 
b) Audio strumming 
c) Internet Browsing Internet browsing 
d) videVideo Calling 

calling20. In which frequency range does Bluetooth technology work? 
a) 2.4 GHz 
b) 5 GHz 
c) 1 GHz 
d) 10 GHz 

 

Assessment-8  Microsoft Word 
  
1. To modify the basic properties of the document 

a) Click on file tab->Info->Properties 
b) Select advanced properties 
c) Click on Custom tab. Now type the name box.  
d) All of the above 

 
 
2. How many times can you use Format Painter before you have to close it? 

a) When you click on the Format Painter button 
b) Double click on the Format Painter button. 
c) Press the Ctrl key and click on the Format Painter button. 
d) Press the Alt key and click on the Format Painter button. 

 
3. Which ribbon in Microsoft Word 2019 contains commands related to inserting a table? 



a) Home 
b) Insert 
c) Page layout 
d) ReferencesAll of the above 

 
4. Which extension is given to MS Word by default? 

a) .EXT 
b) .DOC/DOCx 
c) .COM 
d) All of the above 

 
5. The picture given below shows? 
 
 
 
 

 
a) Mini Toolbar 
b) Print toolbar 

c) Search toolbar 
d) None of the above 

 
6. The picture given below shows. 
 
 

 
 

 
a) Clipboard Command Group 
b) Windows Media Group 
c) Document Group 

d) None of the above 
 
7. Which of the following is not a font style? 

a) Bold 
b) Italic 
c) Regular 
d) SuperScript 

 
8. To create a new document 



 
 

a) Click on File tab, click on New. Inside Backstage View 
b) Click on Blank Document from the available templates. to open a new file 
c) You can also create a new document by pressing Ctrl + N key. 
d) All of the above 

 
9. A letter of general content in MS Word should be sent to 100 recipients. If adding individual recipient 
address to each letter we will use 

a) Embedding 
b) Mail merge 
c) Letters code 
d) Hyperlink 

 
10. To apply styles 

  
 

a) Home> styles group, select normal, no spacing 
b) Home>Editing>styles group, select normal, no spacing  
c) Insert>styles group, select normal, no spacing 
d) Review>styles group, select normal, no spacing 

11. What is the purpose of Find and Replace feature in MS Word 2019?  
a) Spell checking 
b) Formatting text 
c) Searching specific words or phrases 
d) Inserting hyperlink 

12. To wrap text around an object 
a) Select the object and go to Arrange group 
b) Go to Picture Format or Format Position and go to Format with Text Wrapping as per 

requirement. 
c) Both 1 and 2 
d) None of the above 

13. To modify print settings 
a) Click on File > Print 
b) Settings (Print All Pages), click on the drop down. 
c)  Both 1 and 2 
d) None of the above 

14. How can you change line spacing in Microsoft Word 2019? 



a) By adjusting the page margins 
b) Use of line spacing option in Home tab 
c)  byChange font size changing the font size 
d) By applying paragraph style 

15. Which of the following entities is not related to word processing? 
a) Character 
b) Words 
c) Sales 
d) Paragraph 

16. What are gutter margins? 
a) The margin which is on the left while printing 
b)  The margin The which is on the right  while printing margin which is on the right 

side while printing 
c) Margin which is clicking on the left side of the page while printing. 
d) Margin which is clicking on the out  side of the page while printing. 

Margins that extend outsidehile printing and clicking 
17. Which shortcut key is used to undo the last action in Word 2019? 

a) Ctrl+Z 
b) Ctrl+Y 
c) Ctrl+X 
d) Ctrl+C 

18. Displays the Quick Access Toolbar 

 
a) Commonly, frequently used commands 
b) This is done by arranging the commands on different types. 
c) IThese are present at the top of the ribbon and are directlyar 
d) Groups of related commands on the displayed tab 

 
19. Which view in MS Word 2019 allows you to see how the document will look when printed? 

a) Normal 
b) Print layout 
c) Outline 
d) Web layout 

20. Watermark option found in MS Word 2019 
a) Insert tab --> Illustration group 
b) Insert tab --> Links group 
c) Design tab --> Page Background tab 
d) Page Layout tab --> Theme Group 

21. To save a document for the first time 
a) Click the Save button on the Quick Access Toolbar or 
b) The place where the file is placed in the left navigation section 
c) Type a name for the document in the File name box. 
d) abovAll of the above 

 
22. MS Word is an example of 

a) Operating system 



b) Word processing 
c) Application software 
d) Input device 

23. SmartArt for adding graphic content 
a) Select Insert 'a SmartArt, select Layout type. 
b) Select Home 'a SmartArt, select the layout type. 
c) Select Layout 'a SmartArt, select the layout type. 

d) Select Mailings' a SmartArt, select a layout type. 

24.The picture The picture below shows 
a) Advance Property Window Advanced Properties Window 
b) Other Other File Formatsfile formats 
c) Print Settingpint settings 
d) QuickQuick Access Toolbar Access Toolbar 

25.The picture The picture below shows below shows 
a) Home Tab Window 
b) Layout Tab 
c) Insert Tab 
d) Mailing Tab Access Toolbar 

 

 
 

Assessment-9 Microsoft Excel 
 
 
1. What is the purpose of Goal Seek feature in Excel? 

a) Analyzes a range of data 
b) To achieve the desired result 
c) Create a goal-oriented dashboard 
d) Finds the average of a range of values 

2. Which of the following functions is not in MS Excel? 
a) MAX () 
b) AVG() 
c) MIN() 
d) SUM() 

3. Which key is used to create a new line within a cell in Excel? 
a) Enter 
b) Shift 
c) Alt 
d) Ctrl 

4. How do you rearrange data in ascending or descending order in MS Excel 
2019? 

a) Data>Form 
b) Data > Table 
c) Data > Sort 
d) Data>Subtotal 



5. What does the AGGREGATE function do in Excel 2019? 
a) Adds values to the range 
b) Aggregate analysis performers on range of data 
c) Multiplies the values in the range 
d) Adds text to the range 

6. Anand wants to autosum in cell A7 in his worksheet, for this he wants to use the autosum shortcut 
key ALT+=. Look at the picture given here and choose the correct answer from the given options.   

a) The error will appear in cell A7 because the range 
b) The sum of the range A5 : A6 will appear in cell A7. 
c) The sum of the range A2:A6 will appear in cell A7. 
d) A message appears asking you to enter a number in cell A4. 

7. Which language is used to create macro in Excel? 
a) C 
b) VB 
c) Visual C++ 
d) Java 

8. Which function is used to find the highest value in Excel 2019? 
a) MAX () 
b) MIN() 
c) SUM() 
d) AVG() 

9. Which of the following formulas is not entered correctly in Excel? 
a) =97+445 
b) =C8*B1 
c) 97+45 
d) = C9+16 

10. Which menu option can be used to split windows in Excel 2019? 
a) Review>Window>Split 
b) Page Layout>Split 
c) Review>Split 
d) View > Split 

11. Columns are labeled in Excel. 
a) 1,2,3... 
b) A1, A2....  SA1, SA2.... 
c) A, B, C... 

 
12. The title of the worksheet is visible in cell A1, but Suresh wants it to appear in the center from cell 
A1 to cell F1, what should Suresh do for this? 

a) Write the title in cell C1 
b) Select cells A1 to F1 and press Merge & Center.  
c) (cc) cellSelect A1 to F1 and send the title  

d) Write the title in cell C1 and increase the indent. 
13. Using the example shown in the figure below, what will be the result of the formula? 
=IF(MAX(A2:A8)>A5,MAX(A2:A8)*MIN(B2:B8) 

a) 9 
b) 1 
c) 72 



d) 14 
14. What do you mean by Excel Workspace? 

a) Row's group 
b) Group of worksheets 
c) Group of workbooks 
d) Group of columns 

15. What does the function COUNT( ) do in Excel 2019? 
a) Counts the number of cells in a range 
b) Adds values into a range 
c) Finds the average of a range 
d) Multiplies values in a range 

 
16. Shortcut key Ctrl+R is used in Excel. 

a) To right align the contents of a cell rightlign the contents 

of a cell 

b) To fill the selection of active cells to the right 
c) Deleting the contents of selected cells 
d) None of the above 

17. Looking at the diagram of the database, choose the correct formula that can be used to calculate the 
fields in the database.Should be written in B10, where class is Biology and instructor is Vijay 

a) #NAME? 
b) = DCOUNT ( A1 :D8, 4, F2:G3) 
c) =DCOUNT(A1:D8, Marks, F2:G3) 
d) Both 1 and 2 are correct 

18. For the example of DSUM shown in the figure, which of the given statements are true? 
a) DSUM calculates total profit: Tree having Apple 
b) DSUM calculates total profit: Tree Mango having 
c) Both 1 or 2 
d) None of the above 

19. Which statement is true for the folder option marked in blue circle in the picture? 
a)  All recent file locations where you saved the workbook 
b) Properties of workbook 
c) Neither 1 nor 2 statements are true 
d) Both statements 1 and 2 are true 

20. How is the HLOOKUP function different from the VLOOKUP function in Excel 2019? 
a) HLOOKUP searches horizontally, while VLOOKUP searches vertically. 
b) HLOOKUP is used for text, and VLOOKUP is used for 
c) HLOOKUP always returns an exact match, whereas VLOOKUP always returns an exact match.  
d)  HLOOKUP and VLOOKUP are interchangeable, they perform the same function. 

21. Which feature in Excel 2019 can be used to visualize data through bars, lines or pie slices? 
to submitIs it done for? 

a) Conditional formatting 
b) Pivot Tables 
c) Charts 
d) Data validation 



22. Which is the correct formula to calculate the largest number among the numbers kept in cells B1 to 
B7? 

a) =LARGE(B1,B7) 
b) =LARGE(B1:B7) 
c) (s) = LARGE (B1, B7,1) 
d) = LARGE (B1:B7,1) 

23. Cell G2 to cell M12 are the correct references for the cell range? 
a) G2M12 
b) G2;M12 
c) G2:M12 
d) G2-M12 

24. The COUNT function can also count dates if written properly in the correct format 
Rose wants to count how many date entries there are in Column A of her Excel 
worksheet, see the picture and what will be the value displayed in cell B2? 

a) 10 
b) 9 
c) 7 
d) 8 

 
25. Ankit wants to calculate the average of marks of Biology class where Suresh is the instructor. Look at 
the figure shown below and select the correct criteria which should be given in the yellow highlighted 
cells to get the desired result? 
 

a)  Biology and Suresh 
b) Biology and Suresh, Vijay 
c) Biology and Vijay 
d) All of the above 

26. As shown in the figure below, what criteria 
does the DSUM function use? 

a) OR 
b) AND 
c) Both statements 1 and 2 are true 
d) None of the above 

27. Look at the picture and choose the correct answer which should be displayed in cell D2? 
a) 16 
b) 160 
c) 26 
d) 30 

28. In the following example, the field argument is omitted, if the formula =DCOUNT(A1:D8, F2:G3) is 
typed in cell B10, find the correct answer by looking at the figure below. 

a) 8 
b) 3 
c) 0 
d) D entry formula is wrong 
 formulas are incorrect 

 
 
 



 
 
 
 
 

 

Assessment- 10 Microsoft PowerPoint   

 

 
1. Which short cut key inserts a new slide in the current presentation? 

a) Ctrl+N 
b) Ctrl + M 
c) Ctrl+S 
d) All the given 

2. Which of the following allows you to select more than 1 slide in a presentation? 
a) Shift + Click on each slide 
b) ALT+Click on each slide 
c) Ctrl + Click on each slide 
d) Shift+Drag on each slide 

3. Which shortcut key is used to start the presentation from the current slide? 
a) Alt+F5 
b) Shift + F5 
c) Shift+F2 
d) F5 

 4. Which shortcut key to use to copy highlighted text in PowerPoint 2019are done, 
a) Ctrl+C 
b) Ctrl+V 
c) Ctrl+A 
d) Ctrl+Z 

5. What is the purpose of SmartArt feature in PowerPoint 2019? 
a) Inserting animated shapes 
b) Creating dynamic charts 
c) Making graphical representation of information 
d) On the imageAdd 3D effects 

6. To open the presentation 
a) Click on the File tab and select Open. 
b) Select that Folders on the right side of the Open dialog box drivethe left pane of the Open 

dialog box. 
c) Folder in the right pane of the Open dialog box. 
d) All of the above 

7. Which shortcut key is used to duplicate the selected slide in PowerPoint? 
a) Ctrl+T 
b) Ctrl+D 
c) Ctrl+C 
d) Alt+D 

8. Which shortcut key is used to duplicate summary zoom slides? 



 
a) Insert --> Links group --> Zoom drop down menu  
b) Click on Summary Zoom 
c) Select the slide and click on Insert 
d) All of the above 

 
9. How can you password protect a PowerPoint 
presentation? 

a) Using Save As dialog 
b) Go to File tab, select Info and Presentation. 
c) Providing password protection in PowerPoint 
d) None of the above 

10. What does the Record Slideshow feature in PowerPoint 2019 allow you to do? 
a) Recording audio narration for each slide  
b) Recording mouse movements during the presentation 
c) The entire presentation like video 
d) All of the Aboveof the  

above11. When using PowerPoint to run a PowerPoint show from scratch, select . 
a) View, Slide 
b) Slide Show from beginning 
c) View Outline 
d) All of the above 

12. To apply the design theme 
a) Select the Design tab and select the Theme group  
b) Click on the desired theme. 
c) Both 1 and 2 
d) None of the above 

13. What is the purpose of eyedropper tool in PowerPoint? 
a) Measures color accuracy on slides 
b) Formatting one object to another object of one 

ject to another object 
c) Zooms Freezes in on specific slide elements in c  
d) Adjusts the brightness of the presentation 

14. How can you customize the color scheme of handouts in PowerPoint? 
a) Using the color picker tool in the Handout Master 
b) By going to the Design tab and selecting the color scheme. 
c) Handout color scheme automatically slides design 
d) Format background in Handout Master 

15. What is the maximum number of slides per page you can include in handouts? 
a) 2 slides 
b) 3 slides 
c) 6 slides 
d) 9 slides 

 
16. What is the purpose of animation patter in PowerPoint? 

a) Painting the animation directly on the slide 
b) Animation from one object to another 
c) Changing the color of the animation 



d) Creating custom animation 
17. Which shortcut key is used to activate the pen tool during slide show in PowerPoint 
2019? 

a) Use Alt+P 
b) Ctrl+P 
c) Alt+P 
d) Ctrl+T 

18. Which key is used to open the Animation tab in Power Point 2019? 
a) Ctrl+A 
b) Alt+A 
c) Ctrl+A 
d) Ctrl+X 

19. How can you add video to Power Point 2019 slide? 
a) Using the Insert Video option in the Insert tab. 
b) Copying and pasting the URL of the video in the slide 
c) Draging and dropping a video file 
d) On a slide Videos can't be added to PowerPoint 

  added in Power Po 
20. Which key can be used to view a slide show? 

a) F5 
b) F2 
c) F6 
d) F10 

21. Which shortcut key is used to go to the first slide? 
a) Home 
b) End 
c) Ctrl + Home 
d) Tab 

22. Which shortcut is used to open all the slide dialog boxes during a slide show in PowerPoint 2019? 
a) F5 
b) Ctrl+S 
c) F1 
d) Ctrl+A 

23. How can you change the aspect ratio of a PowerPoint presentation? 
a) Go to Slide Show tab and select Aspect Ratio 
b) Using the slide size option in the Design tab 
c) Change the screen resolution of your computer 
d) Aspect threads are not modified in power point. 

24. In which tab is the red marked label feature present? 
a) Home tab 
b) Insert tab 
c) Animation tab 
d) Design tab 

 
 
25. To create a blank PowerPoint presentation 

a) Click on the Start button 
b) Click on the PowerPoint 2019 icon from the options panel. 



c) SelectChoose black presentation option on PowerPoint template the blantion option 

on the PowerPoint template. 

d) oAll of the abovethe above 

26. How to import a Word document outline into Slides? 
a)  Select Home -> New Slide and select Slide Below Outline. 

b) Select the Insert Outline dialog box.Selectsert Outline dialog box. 
c) Both 1 and 2 
d) None of the above 

 
 
 
 

Assessment-11 Cyber Security and Awareness 
 
1. Which type of attack involves sending deceptive emails to reveal sensitive information, including 
passwords? 

a) Brute force attack 
b) Phishing attack 
c) Dictionary attack 
d) Rainbow table attack 

2. A malicious code hidden inside a seemingly harmless code 
is called malicious code. 

a) Worm 
b) Bomb 
c) Trojan Horse 
d) Virus 

3. What is the name of viruses that force users to download 
and execute applications pretending to be useful? 

a) Kayaker 
b) Worm 
c) Trojan Horse 
d) Keylogger 

4. Which of the following is a type of software that contains self-replicating software that replicates files 
and systems? 

a) Virus 
b) Trojan Horse 
c) Bots 
d) wormsVamrse 

5. What does HTTPS mean in a website URL? 
a) Hyper Text Transfer Protocol Secure 
b) Hyper Text Transfer Protocol Stand 
c) SHyper Text Transmission Protocol Secure 
d) Hyper Text Transfer Policy and Secure 



6. A website URL that begins with https:// and includes a padlock icon in the address bar indicates that 
a) The website uses outdated security protocols 
b) A secure connection with website encryption 
c) The website is safe from all types of cyber threats 
d) The website is offline 

7. Full form of VPN is? 
a) Virtual Private Network 
b) Very Private Navigator 
c) Verified Public Network 
d) Visual Proxy Network 

8. What are the uses of firewall? 
a) Filters packets coming from the Internet 
b) Filtering packets coming from the Internet  
c) Filtering packets transmitted over the Internetcoming  

d) Packet Faster Traffic for faster e-commerce 
9. Distributed denial-of-service (DOS) attacks are aimed at 

a) GainingGAINING unauthorized access to a system unauthorized ccess to a 

system 
b) icious softwareMalicious software on computeron the computer 
c) Fills the system with traffic 
d) Encrypting the file and demanding ransom 

10. Which of the following is an independent malicious program that does not require any host 
program? 

a) Virus 
b) Logic bomb 
c) Worm 
d) Trap doors 

11. What is the purpose of regularly clearing browser cache and cookies for safe browsing? 
a) Increasing website performance 
b) Deleting saved passwords 
c) Websites monitor user activity 
d) Disabling browser extensions 

12. When hackers flood a website with useless traffic to put pressure on the network, it is called. 
a) DoS attacks 
b) Spoofing 
c) Fishing 
d) None of the above 

13. Who among the following monitors the activities of users on the Internet and transmits it to 
someone else? 

a) Adware 
b) Spyware 
c)  malwareMaleware 

d) None of the above 
14. Which virus sent people emails with the subject I LOVE YOU in the year 2000? 

a) Love Letter 
b) Lovebug 
c) Valentine connection 
d) Darling Link 



15. Which of the following is a common security feature found in reputable online payment portals? 
 Request for payment in cryptocurrency only 

a) Using HTTP instead of HTTPS 
b)  TwoTwo Factor Authentication for User Accounts 
c)  Pop up ads during payment process 
d) None of the above 

16. What is the primary goal of a credential phishing attack? 
a) Installing malware on a device 
b) intercepting the password during transmission 
c) gaining unauthorized access to a network 
d) Obtaining sensitive information like user name and password. 

17. Malicious programs that do not replicate automatically are called 
a) Trojan Horse 
b) Worm 
c) Zombie 
d) Virus 

18. What is it called when a person tries to harm a group of people by using a computer? 
a) Cracker 
b) Social Engineer 
c) Cyber Terrorist 
d) Wide Hat Intruder 

19. What are keyloggers in the context of password attacks? 
a) Software that generates random passwords. 
b) MaliciousMalicious software that harms someone softwarethat causes harm to 

someone 
c) aA tool to crack password hash tool for cracking password hashes 
d) A type of phishing attack 

20. What is the primary target of a man-in-the-middle (MITM) attack? 
a) stealing personal information 
b) Intercepting or altering communications between two parties 
c)  Overloading a system with traffic  Deleting files from a computer 
d) None of the above 

21. Which computer virus records every activity happening on your computer? 
a) DOS 
b) malware android 
c) Trapper 
d) Keylogger 

22. What does the presence of www in a website URL indicate? 
a) Websites are more reliable 
b) Websites are using old technology 
c) The website is less secure 
d) This is just a naming convention and is meant for security. 

23. Was there a virus which was first found on ARPANET? 
a) Creeper 
b) Stuxnet 
c) Concept 
d) None of the above 

 



 
 

Assessment-12 Other Office Tools 
 
1. What does WPS mean in WPS Office? 

a) Word processing software 
b) Workplace Suite 
c) Wide Spread Presentation System 
d) Writer, Presentation, Spreadsheet 

2. What does the WPS Office Switch feature allow users to do? 
a) Changing the interface language 

b) Toggling between different office applications 
c) Switching between dark and light model 
d) Enabling and disabling automatic updates 

and disabling aut3. What is the purpose of Styles and Formatting feature in Open Office Writer? 
a) Adjusting document margins 
b) Applying pre-defined style to text  
c) nInserting hyperlink 
d) None of the above 

4-.What is the main objective of Open Office Impress? 
a) Word processing 
b) Spreadsheet creation 
c)  Presentation Designpresentation design 

d) Database Management 
Management5. Which file format is usually associated with Open Office Writer documents? 

a) .odp 
b) .ods 
c) .odt 
d) .odb 

6. What is the main purpose of Google Drive in Google Workplace? 
a) Sending and receiving e-mail 
b) Storing and sharing files and documents 
c) Creating and editing spreadsheet 
d) Organizing online meetings 

7. In Google Workspace, which app is suitable for creating and managing surveys and quizzes? 
a) Google Forms 
b) Google Sheets 
c) Google Slides 
d) Google Docs 

8. Which feature in WPS Office allows collaboration on documents in real time? 
a) Co-Editing 
b) Track change 
c) Live editing 
d) Chat integration 

9. Which of the following is a component of WPS Office? 
a) Excel 



b) Power point 
c) Writer 
d) Outlook 

10. Which Open Office application is used to create and manage databases? 
a) Writer 
b) Calc 
c) Base base 
d) Draw 

11. Which Google Workspace app is designed for team messaging and collaboration? 
a) Google Meet 
b) Google Chat 
c) Google Calendar 
d) Google Keep 

12. How do you insert a new sheet in Open Office Calc? 
a) Right click on the Sheet tab and select Insert Sheet. 
b) Use Insert menu and select Insert Sheet  Press Ctrl+N 
c) Double click on the sheet tab 
d) None of the above 

13. Open Office ImpressWhat is the purpose of the Master Slides feature, 
a) Creating animation in slides 
b) Designing the overall layout and format of the slides 
c) Amebedding to multimedia contentembedding multimedia content 
d) Generating slide transition 

14. What is the primary function of WPS spreadsheet? 
a) Create and edit text documents 
b) Design to Presentation designing the presentation 
c) Analyzing and putting data into tables 
d) To editing images and ,Graphics Editing 

 images andaphics15. What is the primary goal of Zoom apps? 

a) To traditional office communication devices 
b) Towards entertainment equipment during meetings 
c) Collaboration and copy within the Zoom platform 
d) Replacement  with social media platforms 

16. What is the primary function of Google Calendar in Google Workspace? 
a) Document collaboration 
b) e-mail communication 
c) Scheduling and organizing events 
d) Spreadsheet creation 

17. In WPS Office, what is the purpose of PDF to Word feature? 
a) Converting PDF files to Word documents 
b) Exporting Word files to PDF format 
c) Merging multiple PDFs into one document 
d) Creating password protected PDF 

18. Which file format is used to save Open Office Calc spreadsheet? 
a) .xlsx 
b) .ods 
c) .odp 
d) .odt 



19. What is the function of Open Office Draw application? 
 Making vector graphics and diagrams 

a) Composing music 
b) Editing photos 
c) Writing code 
d) None 

20. Which of the following is not a part of Open Office Suite? 
a) Draw 
b) Base 
c) equationEquation 
d) Outlook 

21. Which of the following is an advantage of Zoom apps? 
a) Integration with social media platforms 
b) Advanced security features 
c) In-app collaboration and productivity tools 
d) VirtualTo organize Events and Appointment 

 Reality Meeting Experie 

22. What is the main function of Google Meet in Google Workspace? 
a) Creating and editing the document 
b) Organizing video meetings and conferences 
c) Managing project tasks 
d) Organizing events and appointments 

23. Which Open Office applications are suitable for creating and editing vector graphics? 
a) Writer 
b) Calc 
c) Draw  
d) Impress 

24. What is Microsoft Teams mainly used for? 
a) Video gaming 
b) Project Management 
c) Team collaboration and communication 
d) Graphic design 

25. What types of meetings can be organized in Microsoft Teams? 
a) Audio only meetings 
b) Video meetings 
c) Both 1 and 2 
d) Text based meetings 

26. What is the function of SUM() formula in Open Office Calc? 
a) Counting the number of cells 
b) To find the average of the cell 
c) toTo Add value of range cell range 
d) Multiplying values in a range of cells 

27. In which file format can WPS Writer documents be saved? 
a) .doc 
b) .odt 
c) Both 1 and 2 
d) None of the above 

24. Which Google Workspace app is used to create and deliver presentations? 



a) Google Docs 
b) Forms Forms 
c) Google Slides 
d) Google SheetsGoogle Slides 

 

Assessment-13 Useful Application of IT  
 
1. What is the primary purpose of creating a system restore point in Windows? 

a) Freeing up disk space 
b) Updating the operating system 
c) If any issue arises then go to the old statement of the system. 
d) To increase internet speed 

Increasing internet speed2. What is the purpose of a projector screen in a presentation 
setup? 

a) To protect the projector 
b) To increase the audio output 
c) Providing a surface to project images 
d) To control the temperature of the room. 

3. Which connector is usually used to connect a computer to an LCD projector? 
a) HDMI 
b) VGA 
c) USB 
d) Ethernet 

4. What is the purpose of the write-project switch on some USB flash drives? 
a) To increase data transfer speed 
b) To prevent accidental deletion or modification of the data; 
c) To transfer wireless data 
d) sstransf To format the USB drive 

5. What is the purpose of print preview feature in word processing software? 
a) To print the document directly 
b) How will the document appear when printed? 
c) To scan the document for errors 
d) To convert the document into a different format. 

6. Which file format is generally used to prepare the document for printing? 
a) PDF 
b) JPEG 
c) MP3 
d) TXT 

 
7. What is the purpose of print view in computer system? 

a) To store printed documents 
b) To manage print jobs in order managehe sequence of print jobs 
c) To scan documents for printing. 
d) To clean the printer heads 

8. How to transfer data from computer to USB flash drive? 
a) By dragging and dropping files 



b) By printing the data 
c) By scanning the data 
d) By copying and pasting the text 

9. What types of file systems are commonly used for CDs and DVDs? 
a) NTFS 
b) FAT32 
c) ISO 9660 
d) exFAT 

10. Which word refers to the process of copying the entire content of a CD or DVD to the hard drive of a 
computer?ers to, 

a) Disk formatting 
b) Disk cloning 
c) Disk authoring 
d) Disk compression 

11. What is the purpose of the Finalize option when burning a CD or DVD? 
a) To finalize on disk 
b) Closing the disk for further writing 
c) To adapt the disc for speed  
d) To change the color of the disc 

12. What is the function of keystone correction feature in projector? 
a) Adjusting color saturation 
b) Adjusts the projected screen according to the size of the screen. 
c) Controlling screen brightness 

d) scre To enhance 3D effect 
13. What is the aspect ratio of a standard widescreen presentation? 

a) 4:3 
b) 16:9 
c) 2:1 
d) 1:1 

14. Which command is used to safely eject a USB drive on Windows? 
a) CTRL+E 
b) ALT+F4 
c) Right Click --> Eject 
d) Windows Key+R-->Eject 

15. What is the purpose of USB hub? 
a) To charge USB devices 
b) To increase the number of available USB portsoreanumber of available USB po 
c) To encrypt USB data to encrypt USB data 
d) To format the USB drive 

16. In terms of resolution, what does XGA mean? 
a) Extended Graphics Array 
b) Extra Good Expectation 
c) Xerox Graphic Adapter 
d) Xerox gamma adjustment 

17. Which USB version from the options given below provides the fastest data transfer speed? 
a) USB 1.1 
b) USB 2.0 
c) USB 3.0 



d) USB 4.0 
18. Norton. 

a) Anti virus 
b) Vaccine 
c) Antidote 
d) Both 2 and 3 

19. What is the primary function of the printer connected to the computer? 
a) Scanning 
b) Copying 
c) printingPrinting 

d) faxingFaxing 
20. Which file system is commonly used for USB flash drives? 

a) NTFS 
b) FAT32  
c) HFS+ 
d) ext4 

21. In CD/DVD burning, what is meant by the term burn speed? 
a) Temperature required to burn the disc 
b) Time taken to burn a disc 
c) The speed taken to write data on the disk 
d) The amount of fuel used in the burning process. 

22. CD's are full 
a) Central Database  
b) Compact Disk 
c) Computer Drive 
d) Code Developer 

23. Which printing option allows you to print multiple pages of a document on a single sheet of paper? 
a) allows Collated 
b) Duplex 
c) Orientation 
d) Zoom 

24. What is the maximum data transfer speed of USB 3.0? 
a) 480 Mbps 
b) 1 Gbps 
c) 5 Gbps 
d) 10 Gbps 

 

Assessment-14 Exploring Common Citizen Centric Services 
 
 
1. What does PNR mean in the context of IRCTC ticket booking? 

a) Passenger Name Reservation 
b) personal number record 
c) Pooled Number Reservation 
d) Passenger Name Record 

2. Which of the following are the main benefits of creating an account on the RSRCT platform? 
a) Fast buses 



b) priority seating 
c) Special discounts and offers 
d) Free cancellation 

3. What is the primary purpose of Aadhaar card in India? 
a) Driving license 
b) Identity 
c) Passport 
d) Voter ID card 

4. Which ITR form is used by individuals and HUFs having income from business and profession? 
a) ITR-1 (Sehaj) 
b) ITR-2 
c) ITR-3 
d) ITR-4 

5. Which institution is responsible for issuing Aadhaar cards in India? 
a) State government 
b) Election 
c) Unique Identification Authority of India (UIT) 
d) Reserve Bank of India (RBI) 

6. What is the validity period of PAN card? 
a) 5 years 
b) 10 years 
c) Lifetime 
d) Depending on the age of the cardholder 

7. What information is mentioned in the PAN card? 
a) Name and address onl PAN number and date of birth 
b) PAN number, name and photo 
c) Antivirus 
d) None 

8. What safety measures are generally advised to LPG users in Rajasthan to detect gas leakage at home? 
a) Using scented candles 
b) Spraying water around the gas stove 
c) Checking for smell of excess sulfur 
d) Ignoring minor leaks as normal 

9. During the registration process on the RSRCT platform, what information are generally required to be 
provided by the users? 

a) Name, email, and phone number 
b) Aadhaar card details 
c) Physical address and business 
d) Social media profile 

10. Which term is used for waitlisted tickets that are automatically confirmed due to cancellation by 
other passengers? 

a) RAC 
b) PQWL 
c) GNWL 
d) CKWL 

11. What is the purpose of captcha during IRCTC ticket booking process?  
a) Passenger verification 
b) Stopping automated bots 



c) confirmatiPayment confirmationf payment 
d) Ticket cancellation 

12. What are the assessment years for financial year 2022-23? 
a) 2022-23 
b) 2023-24 
c) 2024-25 
d) 2025-26 

13. Describe the steps involved in booking RSRTC e-ticket online and the documents required for 
verification during journey. 

a) Only ID proof is required 
b) Aadhaar card and PAN card are required  Aadhaar card and PAN card are 

required 
c) RegistTo register an account in the booking processan account in the booking 

process 
d) Any document for online booking 

 online booking14. What is the meaning of IRCTC? 
a) Indian Railway Centralized Ticketing Corporation 
b) Indian Railway Catering and Ticketing Corporation 
c) Indian Railways Catering and Tourism Corporation 
d) Indian Railway Centralized Tourism Corporation 

15. In case of change in address, how can you update your PAN card information? 
a) By going online through NSDL website 
b) By visiting the nearest Aadhaar enrollment center 
c) Submit a written request to the Election Commission 
d) None of the above 

16. Which of the following are valid modes of payment for booking tickets on the IRCTC website? 
a) Bitcoin 
b) Credit/Debit Card, Net Banking 
c) Paypal only 
d) Cash on delivery 

17. What is the meaning of PAN? 
a) Personal Authentication Number 
b) Permanent Account Number 
c) Public Access Network 
d) Primary Authorization Node 

18. What is the primary objective of the National Voter Service Portal (NVSP) in India? 
a) Railway ticket booking 
b) Filing income tax 
c) Voter registration and electoral services 
d) Paswsport application 

 

 

Assessment-15 Major eGovernance Services & Schemes for Citizen of Rajasthan 

 
 



1. Which department in the Government of Rajasthan is primarily responsible for implementing e-
governance initiatives? 

a) Education Department 
b) Agriculture Department 
c) InformationDepartment of Technology and Communications 
d) Health Department 

2. How is the eligibility of beneficiaries under Ayushman Yojana determined? 
a) On the basis of income only 
b) Only on the basis of age 
c) Based on a combination of socio-economic factors 
d) Voluntary selection 

3. What is the role of Rajasthan Sampark mobile application? 
a) Train ticket booking 
b) Environmental Violation Reporting 
c) Between citizens and government departments 
d) MobileMobile Banking Service 

 banking service4.What is the primary objective of Rajasthan Sampark Portal? 
a) To facilitate increased social media interaction 
b) Communication between government and citizens 
c) Online gaminggaming 

d) E-commerce transaction 
5 What is the importance of linking Jan Aadhaar Scheme with bank accounts in Rajasthan? 

a) Taking advantage of discounts on shopping 
b) Facility of direct benefit transfer 
c) Opening a fixed deposit 
d) Access to international banking services 

6. What is e-Mitra platform known for in Rajasthan? 
a) Online gaming services 
b) E-Governance Services and Citizen Based Services 
c) Digital currency transactions 
d) Cyber security awareness campaign 

7. What is the meaning of the term e-governance in the context of government services of Rajasthan? 
a) Efficient governance 
b) Electronic governance 
c) Effective governance 
d) Exemplary governance 

  
 
8. Which initiative in Rajasthan focuses on providing digital literacy and computer education in schools? 

a) Digital Rajasthan 
b) e-education 
c) Digital Gram Panchayat 
d) Rajasthan e-learning program 

 9. What security issues are associated with SSO? 
a) Digital Rajasthan 
b) Credential stuffing attack 
c) Simplified user management 
d) Advanced data encryption 



10. What is the role of Ayushman Mitra in the implementation of Ayushman Bharat Mahatma Gandhi 
Rajasthan Health Insurance Scheme? 

a) Running a health awareness campaign 
b) Management of insurance premium 
c) Cashless hospitalization facility 
d) Providing educational scholarships 

11. For whom has Rajasthan Sampark Portal been created? 
a) Online shopping 
b) Government Service Delivery 
c) Entertainment Services 
d) Social networking 

12. What is the purpose of session token in SSO?  
a) Storing user passwords 
b) Verifying user identity 
c) Encrypting data during transmission 
d) User authentication between applications 

13. What is the objective of Rajasthan Single Sign-On (SSO) system? 
a) Access to multiple government services from a single login 
b) Secure password management for citizens Secure password management for 

citizens 
c) Single Window Approval for Business Registrationwindow approval for business 

registration 
d) Signing electronic documents 

14. What is the primary goal of Single Sign-On (SSO)? 
a) Increasing network speed 
b) Handling the user authentication burden 
c) Improving data encryption 
d) Increasing system complexity 

15. What is the role of Common Service Center (CSC) in Rajasthan Sampark Portal? 
a) Hosting of entertainment programs 
b) Providing digital literacy programs 
c) To act as a service point for the portal 
d) Management of agricultural services 

16. Which of the following services can be availed through Rajasthan Sampark Portal? 
a) Bill payments 
b) Apply for government job 
c) Movie ticket booking 
d) All of the above 

 
17. What type of information is available on Jansuchna Portal? 

a) Personal social media 
b) Government circulars 
c) Movie review 
d) E-commerce transactions 

18. What is the primary objective of Ayushman Bharat Mahatma Gandhi Rajasthan Health Insurance 
Scheme? 

a) Financial inclusion 
b) Universal healthcare coverage 



c) Digital literacy 
d) Agricultural subsidy 

19. Which services can be availed using Jan Aadhaar card in Rajasthan? 
a) Public transport booking 
b) PDS ration distribution 
c) Digital literacy 
d) Mobile recharge 

20. What is the objective of Rajasthan Sampark Portal in Rajasthan? 
a) Increasing network speed 
b) Minimizing user Authentication 
c) Improve data encryption authentication burden To 

d) Increasing system complexity 
 
  


